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CHAPTER 10 SETTING UP THE SHOW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Before delivering a presentation, you need to make sure that you 
set up the show for the required presentation mode, such as a 
speaker-led or a self-running presentation. This includes rehearsing 
and applying slide timings as required or recording narration for a 
presentation. 

In this session you will: 

 gain an overview of options for self-running presentations 

 gain an overview of how to record narration and timings 
for a slide show 

 learn how to set up a self-running presentation 

 learn how to rehearse and apply timings for a slide show 

 learn how to set up a speaker-led show. 

INFOCUS 
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ABOUT SELF-RUNNING PRESENTATIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Self-running presentations are commonly used 
at conventions and trade shows, or even the 
waiting room at your local doctor’s office! Self-
running presentations are designed to run without 

a speaker present so the presentation should 
therefore provide enough time for the user to read 
the information, as well as to provide clear 
navigation cues for the audience if required. 

Setting Up A Self-running Presentation 

For most self-running presentations, you will set up the slides to advance automatically after a 
specified period of time. This is done by assigning automatic timings to each slide.  

You can use the Rehearse Timings feature to apply the same timing to all slides. Alternatively 
you can assign variable timings to each slide, which is particularly useful where some slides 
contain less content than other slides (such as title slides). For example, you might read through 
each slide when rehearsing timings to determine how much time it will take your audience to read 
and absorb the information. 

Adding Narration To A Self-running Presentation 

You can add narration to a self-running presentation. As everyone absorbs information in 
different ways (such as auditory or visual learners) this can help to deliver your message more 
effectively. To add narration, you record the slide show. PowerPoint will record the amount of 
time that you spend viewing each slide, and at the same time you can record narration for the 
slides as required. PowerPoint will store the timing for each slide, and will also store the recorded 
on each slide (displayed as a speaker icon on slides). Timings applied to each slide can be 
viewed in Slide Sorter view.   

Note that you will need specific hardware to record the narration, such as a sound card in your 
computer, a microphone and speakers. Hardware requirements are discussed in more detail on 
the following page. 

An alternative to recording the slide show is to record specific sounds or comments on relevant 
slides. This is achieved by selecting Audio and then Record Audio on the Insert tab. Again, you 
will require the necessary hardware as noted above.  

Enabling User Navigation 

If you want your audience to be able to navigate through a presentation at their own pace, you 
can disable any automatic timings and instead provide navigation cues for the audience, such as 
action buttons or hyperlinks.  

For example, you can insert an action button in the shape of an arrow with the word ‘Next’ as a 
cue to the audience that they can click on this button to advance to the next slide. Action buttons 
give the look and feel of a web page with easily recognisable navigation icons such as Home, 
Help, Next Page, Last Page, and so on. 

Alternatively, you can create hyperlinks for custom shows (which display specific slides within 
your presentation), other presentations, Word or Excel files, specific addresses on the internet, or 
to email addresses. You can create hyperlinks from any object − including text, shapes, tables 
and pictures. 
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RECORDING A SLIDE SHOW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you are setting up a self-running presentation 
for viewing by a particular audience or the 
general public, such as at trade show, you might 
decide it’s a good idea to add narration to the 

presentation. In this way, the presentation will be 
seen as well as heard! Here we give you an 
overview of how to record narration and timings for 
a self-running presentation 

Hardware Required 

To enable you to record and playback the narration, you will require the following hardware: 

 A sound card installed on your computer. This enables you to hear sound. Most computers 
will already have this device installed. 

 Computer speakers. Most computers today have built-in speakers which should be enabled by 
default. You may need to check that the volume is working. You can do this by clicking on the 
Speakers icon (or similar) on the Taskbar and check that the sound is not turned off (or 
unmuted), and then adjust the volume to the desired level. 

 A microphone to record your narration. For most computers, you can simply plug the 
microphone into the available microphone plug (a round plug with a microphone icon just above 
it or labelled ‘mic-in’) at the rear of your computer (for desktop computers) or along the side or 
rear of your laptop computer.  

You can then begin recording your narration in PowerPoint. 

Recording The Slide Show 

The following is a guide to recording narrations for a slide show.  

1. When you are ready to record the narration for each slide, click on the Slide Show tab, then 
click on Record Slide Show. You then select Start Recording from Beginning or Start 
Recording from Current Slide. If you select the latter option, ensure that the required slide is 
displayed in the Slides window or selected in Slide Sorter view. 

You do not necessarily have to record in sequence. Also you can pause during recording and 
resume at any time. 

2. The Record Slide Show dialog box will then appear asking you if you want to record narrations 
(Narrations and laser pointer) and timings (Slide and animation timings). Both of these 
options are selected by default. To record both narrations and slide timings, leave both of these 
options selected and then click on [Start Recording]. 

3. The first (or selected) slide will appear, along with the Recording toolbar. The Recording 
toolbar will record the timings for each slide. You can advance to the Next slide when you 
finished recording narration for the current slide, or Pause recording and timing. You can also 
re-record by clicking on Repeat. 

4. To end the recording at any time, press . 

Previewing The Narration 

Timings are saved and these will be display in Slide Sorter view. Any recorded narration will appear 
as a sound icon on the slide. To listen to a recorded narration, navigate to the slide, click on the 
sound icon, click on the Playback tab, then click on Play in the Preview group. If you’re not satisfied 
with the recording, simply press   to delete it. To re-record narration for that slide, click on the 

Slide Show tab, then click on Record Slide Show and select Start Recording from Current Slide.  

Setting Up The Show 

By default, timings and narrations will be applied when you set up the presentation as a self-running 
presentation. To set up the presentation as a self-running presentation, click on the Slide Show tab, 
then click Set Up Slide Show to open the Set Up Show dialog box. Then click on Browsed at a 
kiosk option under Show Type. You can hide the sound icons on each slide by selecting the sound 
icon, clicking on the Playback tab and then clicking on Hide During Show in the Audio Options 
group so that it appears with a tick. 
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SETTING UP A SELF-RUNNING PRESENTATION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

Try This Yourself: 
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 Before starting this exercise you 

MUST open the file P819 Setting 
Up The Show_1.pptx... 

 Navigate to and display slide 1 in 
the Slides window, click on the 
Transitions tab, then click on 
After in the Timing group so that 
it appears with a tick 

We’ll set slide advancement for 
15 seconds… 

 Click on the up arrow  for After 
until it reads 00:15.00 

 Click on Apply To All  in the 

Timing group to apply this timing 
to all slides 

Now we’ll set up the show as a 
self-running presentation… 

 Click on the Slide Show tab, 
then click on Set Up Slide Show 

 in the Set Up group to open 

the Set Up Show dialog box 

 Click on Browsed at a kiosk 
(full screen) to apply this setting, 
ensure that Use timings, if 
present is selected for Advance 
slides, then click on [OK] 

Self-running presentations will 
loop continuously be default… 

 Click on Slide Show  in the 

Status bar to preview the slide 
show, then press  when 

finished 

 

For Your Reference… 

To set up a self-running presentation: 

1. Click on the Transitions tab, click on After, 
set a timing in After, then click on Apply to 
All to apply to all slides 

2. Click on the Slide Show tab, click on Set Up 
Slide Show, select Browsed at a kiosk (full 

screen) and click on [OK] 

Handy to Know… 

 You can set different timings for each slide. 
This is useful when you want shorter slide 
progressions for title slides, for example. To 

do this, click on Slide Sorter View  in the 

Status bar, click on a slide to select it, click 
on the Transitions tab and apply the 
required timing in After in the Timing group. 

 

1 2 

When finalising a self-running presentation, 
such as at a kiosk or trade show, the audience 
must have time to read and digest the content on 
a slide before the slide progresses to the next 

one. Where you have included action buttons, for 
example, users can simply click on the button to 
progress to the next slide. Alternatively, you can 
apply timings for slide advancement. 

4 
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REHEARSING TIMINGS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Before starting this exercise you 

MUST open the file P819 Setting 
Up The Show_2.pptx... 

 Click on the Slide Show tab, then 

click on Rehearse Timings  in 

the Set Up group 

The slide show will begin and the 
Recording toolbar will appear, 
showing the timing of the current 
slide as well as the overall slide 
show time... 

 Pretend you are presenting the 
content on the slide, or pretend you 
are the audience reading the slide 
(such as at a kiosk), then click on 

Next  on the Recording toolbar 

to progress to the next slide 

 Repeat the above step for each 
slide until you arrive at the last slide 
(title slide) 

 Right-click on the slide and select 
End Show 

A message box will appear telling 
you the length of the show and 
asking if you want to keep the new 
timings... 

 Click on [Yes] to save the timings 

The slides will appear in Slide 
Sorter view with the timings 
displayed below each slide... 

 Return to Normal view 

 

For Your Reference… 

To rehearse slide timings: 

1. Click on the Slide Show tab, then click on 

Rehearse Timings  in the Set Up group 

2. Read/rehearse the presentation, and click on 

Next  to progress through each slide 

3. Click on [Yes] to retain the timings 

Handy to Know… 

The Recording toolbar tools are as follows: 

 Next: to move to the next slide 

 Pause: to pause recording 

 Slide Time: displays the timing; you 

can also type an exact timing into this box 

 Repeat: to re-record the current slide. 

 

1 

4 

Instead of applying the same timing to each slide 
or guessing an approximate timing for each one, 
you can use the rehearse timings feature to 
record exactly how much time is required to read 

or speak during each slide. These slide timings can 
then be automatically applied to the presentation if 
desired. This feature is useful for both self-running 
and speaker-led presentations. 

5 
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SETTING UP A SPEAKER-LED SHOW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous file 
with this exercise, or open the file 
P819 Setting Up The 
Show_3.pptx... 

 Click on the Slide Show tab, then 

click on Set Up Slide Show  in 

the Set Up group to open the Set 
Up Show dialog box 

First we need to select the type of 
show… 

 Click on Presented by a speaker 
(full screen) for Show type  

This is the standard option for a 
speaker-led presentation. As the 
presenter will be speaking during 
the show, we’ll also disable the 
narration option… 

 Click on Show without narration 
under Show options so that it 
appears with a tick 

Although timings have been set, 
we’ll turn these off so that the 
speaker can manually advance 
each slide when required… 

 Click on Manually for Advance 
slides to select this option, then 
click on [OK] to apply the settings 

 Click on From Beginning  in 

the Start Slide Show group to 
start the show 

 Click to advance each slide, then 
press  to end the show 

 

For Your Reference… 

To set up a speaker-led show: 

1. Click on Set Up Slide Show  in the Set 

Up group on the Slide Show tab 

2. Click on Presented by a speaker (full 
screen), then click on Manually 

3. Click on [OK] 

Handy to Know… 

 If you have applied animations to text and 
objects, it may take a significant time to get 
through the presentation. This is fine if you 
have plenty of time, but if you don’t you can 
disable the animations by selecting Show 
without animation under Show options in 
the Set Up Show dialog box. 
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The most common mode of presentation delivery 
is the speaker-led show. During this type of 
presentation, the speaker will manually advance 
each slide when required, thereby giving the 

speaker full control over the presentation. As such, 
timings for slide advancement will usually be 
disabled, however, the speaker can apply and 
rehearse timings if desired. 


